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Figure S1: Reaction scheme for synthesis of chondroitin sulfate methacrylate (CSMA). Chondroitin 
sulfate (CS) was functionalized by covalently attaching methacrylate groups via ester bonds. CS was 
dissolved in water and reacted with methacrylic acid at room temperature (RT) for 24 hours. The pH of the 
reaction was maintained at approximately 8 by adding 1.12 molar equivalents of NaOH relative to 
methacrylic anhydride. The product, CSMA, was precipitated in methanol and purified by dialysis in 
deionized water to remove byproducts and excess reagents.

Figure S2: ¹H-NMR spectrum of CSMA in D₂O (500 MHz): The spectra of CSMA exhibit characteristic 
signals corresponding to the methacrylate moiety, confirming successful conjugation. The vinyl protons (C) 
and methyl protons (B) from the methacrylate group are clearly observed. The integration of the methyl 
proton peak (C) from chondroitin sulfate (CS) was calibrated to 3, as each monomer unit contains one 
methyl group. The degree of substitution was determined by integrating the vinyl proton peaks. An 
integration value of 0.8 for the vinyl peaks indicates that 8 methacrylate units are functionalized per 10 
repeat units of CS.
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Figure S3: Overlapping ¹H-NMR spectra of CS (bottom) and CSMA (top) in D₂O (500 MHz): The spectra 
of CSMA exhibit characteristic signals corresponding to the methacrylate moiety, confirming successful 
conjugation, which are not present in the spectra of CS. 

Figure S4: Schematic representation of poly(L-lysine) (PLL) synthesis. L-Lys(Z)-OH was dissolved in 
dry THF and reacted with triphosgene at 50 °C under an air-free environment to yield the L-Lys(Z)-
NCA monomer. The purified monomer was polymerized in dry DMF under mild vacuum conditions 
using hexylamine as the initiator. The resulting polymer was dissolved in TFA, and HBr was added to 
remove the CBz protecting group, yielding PLL.

Table S1: Molar concentrations of PLL and primary amines in CSMA-PLL hydrogels as PLL DP and 
%w/w varies.

PLL chain length Moles of PLL in 
hydrogels 

Moles of primary amine -
NH2 in hydrogels

2.5% w/w
DP 15 11.4 mM 171 mM

DP 35 4.9 mM 171 mM

DP 50 3.4 mM 171 mM

5% w/w
DP 15 22.8 mM 342 mM

DP 35 9.8 mM 342 mM

DP 50 6.8 mM 342 mM
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Figure S5: ¹H-NMR spectrum of L-Lys(Z)-NCA in CDCl₃ (500 MHz) shows distinct peaks with specific 

proton assignments and their corresponding integration values, confirming the structure of the monomer. a 

(7.38 ppm), b (5.13 ppm), c (4.90 ppm), d (3.22 ppm), e, f, g (1.4-2.01 ppm) , h (4.3 ppm), i (6.57 ppm).

Figure S6: ¹H-NMR spectrum of Poly(L-Lys(Z)) in DMSO-d₆ (500 MHz): The spectrum displays 
characteristic peaks, including those from the methyl end group (highlighted in blue, 0.83 ppm) originating 
from the hexylamine initiator. The methyl peak is calibrated to 3, serving as a reference for further 
integrations. The benzylic proton peaks (highlighted in red, 4.95 ppm) are integrated to determine the 
degree of polymerization (DP). Since each monomer unit contains two benzylic protons, the DP is 
calculated by dividing the total integration of benzylic protons by 2. In this example, the integration of 
benzylic protons is 97, corresponding to a DP of approximately 48.
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Figure S7: ¹H-NMR spectrum of Poly(L-Lys(Z)) (PLL) with DP 15 in DMSO-d₆ (500 MHz).

Figure S8: ¹H-NMR spectrum of Poly(L-Lys(Z)) (PLL) with DP 35 in DMSO-d₆ (500 MHz).
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Figure S9: ¹H-NMR spectrum of Poly(L-Lys(Z)) (PLL) with DP 50 in DMSO-d₆ (500 MHz).

Figure S10: Overlaid ¹H-NMR spectra of Protected Poly(L-Lys(Z))₅₀ (Top) and Deprotected Poly(L-

Lysine)₅₀ (PLL₅₀) (Bottom) in DMSO-d₆ (500 MHz): The spectrum of protected Poly(L-Lys(Z))₅₀ shows 

distinct peaks corresponding to the methyl (4.95 ppm) and aromatic (7.01-7.30 ppm) protons of the CBz 

protecting group. Upon deprotection, the disappearance of these peaks in the PLL₅₀ spectrum confirms the 

complete removal of the CBz group, indicating successful deprotection.
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Figure S11: (A) Rheology setup for real time assessment of changes in viscoelasticity of hydrogels upon 

photocuring. (B) Dynamic viscosity of CSMA-PLL hydrogels with respect to varying PLL chain lengths and 

weight percentages compared to neat CSMA. The box plot represents the 25th and 75th percentiles as the 

edges of the box, with the median indicated by the line inside the box. The error bars in the box plots 

correspond to the interquartile range (IQR), n=3.

Figure S12: Viscoelastic properties of CSMA-PLL hydrogels upon photocuring with UV-Vis light (350-500 

nm). (A) Gelation time for the CSMA-PLL hydrogels with varying PLL chain lengths (DP) and PLL weight 

percentage compared to neat CSMA hydrogels. Comparison of (B) G’ and (C) G” of CSMA-PLL hydrogels. 

Comparison of (D) yield stress; (E) yield strain (%) and (F) linear viscoelastic range (LVR) obtained from 

the amplitude sweeps of CSMA-PLL hydrogels with varying PLL chain lengths (DP) and PLL weight 

percentage. The box plot represents the 25th and 75th percentiles as the edges of the box, with the median 

indicated by the line inside the box. The error bars in the box plots correspond to the interquartile range 

(IQR), n=3.
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Figure S13: ¹H-NMR spectrum of L-Lysine in D2O (500 MHz) shows distinct peaks with specific proton 

assignments and their corresponding integration values, confirming the structure. a (3.23 ppm), b (1.55 

ppm), c (1.30 ppm), d (1.55 ppm), e (2.85 ppm).

Figure S14: ¹H-NMR spectrum of D-glucose in D2O (500 MHz) shows distinct peaks with specific proton 

assignments and their corresponding integration values, confirming the structure. a (5.16 ppm), b (3.46 

ppm), c (3.65 ppm), d (3.34 ppm), e (3.70 ppm), f (3.77 ppm).
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Figure S15: ¹H-NMR spectrum of glucose-MA in D₂O (500 MHz): The spectra of glucose-MA exhibit 
characteristic signals corresponding to the methacrylate moiety, confirming successful conjugation. The 
vinyl protons (m1, m2) and methyl protons (g) from the methacrylate group are clearly observed. 

Figure S16: ¹H-NMR spectrum of glucose-MA in D2O (500 MHz) shows distinct peaks with specific proton 

assignments and their corresponding integration values, confirming the structure. a (5.17 ppm), b (3.46 

ppm), c (3.65 ppm), d (3.34 ppm), e (3.70 ppm), f (3.77 ppm).
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Figure S17: Temporal changes in the vinyl proton signals of methacrylated compounds (e.g., Glucose-MA 

or CSMA) monitored over 60 minutes upon interaction with primary amine-containing molecules (e.g., 

Lysine-OH or PLL).

Figure S18: SEM micrographs of freeze dried CSMA hydrogels incorporated with 5% w/w of PLL DP 35. 

Hydrogels with 5%w/w of PLL DP35 exhibit relatively larger pores (2-180 m) visible only at lower 

magnification.
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Figure S19: Analysis of pore frequency and pore size distribution in CSMA-PLL hydrogels as observed in 

SEM micrographs was performed using ImageJ. (A) Variation of the pore frequency as function of molecular 

weight between crosslinks (PLL DP) and %w/w PLL incorporation. (B) Median of pore area distribution in 

CSMA-PLL hydrogels as function of molecular weight between crosslinks (PLL DP) and %w/w PLL 

incorporation. The box plot represents the 25th and 75th percentiles as the edges of the box, with the 

median indicated by the line inside the box. The error bars in the box plots correspond to the interquartile 

range (IQR), n=3.
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Figure S20: Pore size distribution of the CSMA-PLL hydrogels with varying molecular weight between 

crosslinks (PLL DP) and %w/w PLL incorporation: (A) Neat CSMA; CSMA-PLL hydrogel with PLL DP 15 

(B) 5% w/w (C) 2.5% w/w; CSMA-PLL hydrogel with PLL DP 35 (D) 5% w/w (E) 2.5% w/w; CSMA-PLL 

hydrogel with PLL DP 50 (F) 5% w/w (G) 2.5% w/w.
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Figure S21: Stress versus strain curves for CSMA-PLL hydrogels when compressed at strain rate of 0.02 

mm/s: (A) Neat CSMA; CSMA-PLL hydrogel with PLL DP 15 (B) 5% w/w (C) 2.5% w/w; CSMA-PLL hydrogel 

with PLL DP 35 (D) 5% w/w (E) 2.5% w/w; CSMA-PLL hydrogel with PLL DP 50 (F) 5% w/w (G) 2.5% w/w. 

The yield point indicating the strain at which the hydrogels are pointed with dotted lines of corresponding 

colors and labeled. 
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Figure S22: Stress versus strain curves for swollen CSMA-PLL hydrogels when compressed at strain rate 

of 0.02 mm/s: (A) Neat CSMA; CSMA-PLL hydrogel with PLL DP 15 (B) 5% w/w (C) 2.5% w/w; CSMA-PLL 

hydrogel with PLL DP 35 (D) 5% w/w (E) 2.5% w/w; CSMA-PLL hydrogel with PLL DP 50 (F) 5% w/w (G) 

2.5% w/w. The yield point indicating the strain at which the hydrogels are pointed with dotted lines of 

corresponding colors and labeled.

Figure S23: Comparison of toughness of CSMA-PLL hydrogels determined from compression stress-strain 

curve: (A) hydrogels tested in fresh state; (B) hydrogels in tested swollen state. The box plot represents the 

25th and 75th percentiles as the edges of the box, with the median indicated by the line inside the box. The 

error bars in the box plots correspond to the interquartile range (IQR), n=3.
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Statistical analysis
Table S2: Statistical comparison of gelation times of CSMA-PLL hydrogels upon photocuring, p-values are 
reported. Statistical analysis performed using Hypothesis testing function, Mann Whitney U test in 
Mathematica, wherein p-value <0.05 indicates significant difference and are highlighted in red. 

PLL DP15 PLL DP35 PLL DP50 CSMA
PLL %w/w 5% 2.5% 5% 2.5% 5% 2.5% 0%

5% 0.0650 0.0399 0.0431 0.1157 0.1573 0.0268PLL DP15 2.5% 0.0650 0.0707 0.7962 0.5049 0.0204
5% 0.2611 0.8221 0.1573 0.0636PLL DP35 2.5% 0.3687 0.1642 0.6625
5% 0.8137 0.3827PLL DP50 2.5% 0.0268

CSMA 0%

Table S3: Statistical comparison of storage modulus of photocured CSMA-PLL hydrogels, p-values are 
reported. Statistical analysis performed using Hypothesis testing function, Mann Whitney U test in 
Mathematica, wherein p-value <0.05 indicates significant difference and are highlighted in red. 

PLL DP15 PLL DP35 PLL DP50 CSMA
PLL %w/w 5% 2.5% 5% 2.5% 5% 2.5% 0%

5% 0.0268 0.0268 0.0268 1.0000 0.0246 0.3758PLL DP15 2.5% 0.0290 1.0000 0.0808 0.6579 0.0808
5% 0.0808 0.0808 0.0765 0.0808PLL DP35 2.5% 0.0808 0.6579 0.0808
5% 0.0268 0.3827PLL DP50 2.5% 0.0765

CSMA 0%

Table S4: Statistical comparison of loss modulus of photocured CSMA-PLL hydrogels, p-values are 
reported. Statistical analysis performed using Hypothesis testing function, Mann Whitney U test in 
Mathematica, wherein p-value <0.05 indicates significant difference and are highlighted in red. 

PLL DP15 PLL DP35 PLL DP50 CSMA
PLL %w/w 5% 2.5% 5% 2.5% 5% 2.5% 0%

5% 0.0765 0.0268 0.1840 0.6579 0.0246 0.3758PLL DP15 2.5% 0.0290 1.0000 0.3827 0.0268 0.1904
5% 0.0808 0.0808 0.0765 0.0808PLL DP35 2.5% 1.0000 0.3758 0.3827
5% 0.0268 0.3827PLL DP50 2.5% 0.0765

CSMA 0%
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Table S5: Statistical comparison of yield stress of CSMA-PLL hydrogels upon amplitude sweep, p-values 
are reported. Statistical analysis performed using Hypothesis testing function, Mann Whitney U test in 
Mathematica, wherein p-value <0.05 indicates significant difference and are highlighted in red. 

PLL DP15 PLL DP35 PLL DP50 CSMA
PLL %w/w 5% 2.5% 5% 2.5% 5% 2.5% 0%

5% 0.0290 0.0290 0.0268 0.0808   0.0268 0.0290PLL DP15 2.5% 0.0290 0.6579 0.6625 0.6579 0.0808
5% 0.0765 0.0808 0.0765 0.0808PLL DP35 2.5% 0.3758 0.3686 0.3758
5% 0.1840 0.3827PLL DP50 2.5% 0.0765

CSMA 0%

Table S6: Statistical comparison of yield strengths of swollen CSMA-PLL hydrogels, p-values are reported. 
Statistical analysis performed using Hypothesis testing function, Mann Whitney U test in Mathematica, 
wherein p-value <0.05 indicates significant difference and are highlighted in red. 

PLL DP15 PLL DP35 PLL DP50 CSMA
PLL %w/w 5% 2.5% 5% 2.5% 5% 2.5% 0%

5% 0.1904 0.3827 0.6625 0.3827 0.6625 0.1904PLL DP15 2.5% 0.3827 0.6625 0.3827 0.6625 0.1904
5% 0.6625 0.6625 0.6625 0.6625PLL DP35 2.5% 0.3827 1 0.1904
5% 1 0.6625PLL DP50 2.5% 0.3827

CSMA 0%

Table S7: Statistical comparison of ultimate compression strengths of swollen CSMA-PLL hydrogels, p-
values are reported. Statistical analysis performed using Hypothesis testing function, Mann Whitney U test 
in Mathematica, wherein p-value <0.05 indicates significant difference and are highlighted in red. 

PLL DP15 PLL DP35 PLL DP50 CSMA
PLL %w/w 5% 2.5% 5% 2.5% 5% 2.5% 0%

5% 0.6625 0.3827 0.6625 0.0290 0.6625 0.0808PLL DP15 2.5% 0.3827 0.3827 0.0808 0.6625 0.0808
5% 0.6625 1 1 0.6625PLL DP35 2.5% 0.0808 0.6625 0.6625
5% 0.6625 0.3827PLL DP50 2.5% 0.3827

CSMA 0%
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Table S8: Statistical comparison of yield strengths of CSMA-PLL hydrogels, p-values are reported. 
Statistical analysis performed using Hypothesis testing function Mann Whitney U test in Mathematica, 
wherein p-value <0.05 indicates significant difference and are highlighted in red. 

PLL DP15 PLL DP35 PLL DP50 CSMA
PLL %w/w 5% 2.5% 5% 2.5% 5% 2.5% 0%

5% 0.6625 0.6625 0.0808 0.1904 0.0808 0.3827PLL DP15 2.5% 0.6625 0.0808 0.0808 0.0808 1
5% 0.0808 0.0808 0.0808 1PLL DP35 2.5% 0.6625 0.0808 0.1904
5% 0.6625 0.1904PLL DP50 2.5% 0.0290

CSMA 0%

Table S9: Statistical comparison of ultimate compression strengths of CSMA-PLL hydrogels, p-values are 
reported. Statistical analysis performed using Hypothesis testing function, Mann Whitney U test in 
Mathematica, wherein p-value <0.05 indicates significant difference and are highlighted in red.

PLL DP15 PLL DP35 PLL DP50 CSMA
PLL %w/w 5% 2.5% 5% 2.5% 5% 2.5% 0%

5% 0.0808 0.1904 0.1904 0.0808 0.0808 0.1904PLL DP15 2.5% 0.3827 0.0808 1 1 0.1904
5% 0.3827 0.3827 0.1904 1PLL DP35 2.5% 0.3827 0.0808 0.6625
5% 0.3827 0.3827PLL DP50 2.5% 0.3827

CSMA 0%

Table S10: Statistical comparison of storage modulus (G’) of CSMA-PLL hydrogels before (fresh) and after 
enzyme degradation (ED), p-values are reported. Statistical analysis performed using Hypothesis testing 
function, Mann Whitney U test in Mathematica, wherein p-value <0.05 indicates significant difference and 
are highlighted in red. 

PLL DP15 PLL DP35 CSMA
Fresh ED Fresh ED Fresh ED

Fresh 1 0.3758 0.1904 0.0808 0.0808PLL DP15 ED 1 1 0.0808 0.0808
Fresh 0.6579 0.0765 0.0765PLL DP35 ED 0.0808 0.0808
Fresh 0.0808CSMA ED
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Table S11: Statistical comparison of loss modulus (G”) of CSMA-PLL hydrogels before (fresh) and after 
enzyme degradation (ED), p-values are reported. Statistical analysis performed using Hypothesis testing 
function, Mann Whitney U test in Mathematica, wherein p-value <0.05 indicates significant difference and 
are highlighted in red. 

PLL DP15 PLL DP35 CSMA
Fresh ED Fresh ED Fresh ED

Fresh 0.3827 0.3758 0.6625 0.3827 0.0808PLL DP15 ED 0.6579 0.6625 0.3827 0.1904
Fresh 0.6579 0.3758 0.1840PLL DP35 ED 0.3827 0.0808
Fresh 0.1904CSMA ED

Table S12: Statistical comparison of yield stress upon amplitude sweep of CSMA-PLL hydrogels before 
(fresh) and after enzyme degradation (ED), p-values are reported. Statistical analysis performed using 
Hypothesis testing function, Mann Whitney U test in Mathematica, wherein p-value <0.05 indicates 
significant difference and are highlighted in red. 

PLL DP15 PLL DP35 CSMA
Fresh ED Fresh ED Fresh ED

Fresh 1 0.3758 0.1904 0.0808 1PLL DP15 ED 1 0.3827 0.1904 0.3827
Fresh 0.6579 0.1840 0.1840PLL DP35 ED 0.3827 0.0808
Fresh 0.0290CSMA ED

Table S13: Statistical comparison of yield strain upon amplitude sweep of CSMA-PLL hydrogels before 
(fresh) and after enzyme degradation (ED), p-values are reported. Statistical analysis performed using 
Hypothesis testing function, Mann Whitney U test in Mathematica, wherein p-value <0.05 indicates 
significant difference and are highlighted in red. 

PLL DP15 PLL DP35 CSMA
Fresh ED Fresh ED Fresh ED

Fresh 0.1904 0.3827 0.1904 0.0808 0.0808PLL DP15 ED 0.0290 0.6625 1 0.0808
Fresh 0.1904 0.0808 0.0808PLL DP35 ED 1 0.0808
Fresh 0.1904CSMA ED
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Figure S24: Comparison of hMSCs cell viability in chondrogenic media after 3 weeks. The number of live 

cells was determined by calcein AM staining, followed by fluorescent imaging. ImageJ was used to 

determine the number of live cells as visible from the topmost layer of the hydrogels in an area of 1 mm2. 

The box plot represents the 25th and 75th percentiles as the edges of the box, with the median indicated 

by the line inside the box. The error bars in the box plots correspond to the interquartile range (IQR), n=3.

Figure S25: Brightfield true-color images and images captured with parallel and cross polarizers of sirius 

red F3B-stained hydrogels without hMSCs. These images serve as a control to confirm that Sirius Red F3B 

21



selectively stains collagen and no other matrix components. The results show that Sirius Red F3B does not 

stain CSMA hydrogels but does stain CSMA-PLL hydrogels, likely due to interactions with the positively 

charged lysine groups of PLL. True-color images of the same field of view were captured under parallel 

polarizers (top) and crossed polarizers (bottom). While PLL is stained by Sirius Red F3B, no birefringence 

is observed, distinguishing it from the birefringence exhibited by ordered collagen fibers. 

Figure S26: Alkaline Phosphatase (ALP) staining and quantification of hMSCs in hydrogels: Human 

mesenchymal stem cells (hMSCs) were cultured on tissue culture plastic (TCPS) as a control or 

encapsulated in CSMA and CSMA-PLL hydrogels. After 7 days in growth media, the cells were maintained 

in chondrogenic differentiation media for an additional 3 weeks. To assess whether hMSCs were 

undergoing endochondral ossification toward a bone phenotype, they were stained for alkaline 

phosphatase (ALP), an osteoblast marker. ALP staining appears red, and the absence of red staining 

indicates that hMSCs were not undergoing endochondral ossification.  (A) A standard curve was generated 

to determine ALP concentration in hMSCs. (B) ALP quantification across different conditions revealed that 

hMSCs cultured on TCPS exhibited an ALP concentration of approximately 20 µg/mL, whereas those 

encapsulated in CSMA and CSMA-PLL hydrogels showed minimal ALP expression. These results suggest 

that hydrogel encapsulation significantly suppresses the endochondral ossification of hMSCs compared to 

cells grown on TCPS. The box plot represents the 25th and 75th percentiles as the edges of the box, with 

the median indicated by the line inside the box. The error bars in the box plots correspond to the interquartile 

range (IQR), n=3.

A.1 Enzymatic degradation of CSMA-PLL hydrogels with Chondroitinase ABC

 The amount of enzyme added for each CSMA-PLL hydrogel sample is about 0.83 μg in 1 mL of 
buffer

 Enzyme amount = 0.83 μg

 The hydrogels used for this study weighed around 40 mg, and the concentration of CSMA is 8% 
leading to amount of cleavable substrate to be around 3.2 mg. When divided by the molecular 
weight of CS repeat unit (463 g/mol), we get the moles of cleavable substrate in the hydrogel to 
be 6.9 μmol. 
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           Substrate amount = 6.9 μmol

 Enzyme activity as per manufacturer = 15,000 pmol/min/μg

Step 1: Calculate Total Activity of 0.83 μg of Enzyme

Total Activity = 0.83 × 0.015 μmol/min = 0.01245 μmol/min

This means 0.01245 μmol of CS substrate is degraded per minute.

Step 2: Estimate Time for Complete Breakdown

𝑇𝑖𝑚𝑒 =  
𝑇𝑜𝑡𝑎𝑙 𝑆𝑢𝑠𝑏𝑡𝑟𝑎𝑡𝑒 (𝜇𝑚𝑜𝑙)

𝑅𝑎𝑡𝑒 𝑜𝑓 𝐵𝑟𝑒𝑎𝑘𝑑𝑜𝑤𝑛 (𝜇𝑚𝑜𝑙/𝑚𝑖𝑛)

𝑇𝑖𝑚𝑒 =  
6.9 𝜇𝑚𝑜𝑙

0.01245 𝜇𝑚𝑜𝑙/𝑚𝑖𝑛 
= 554.2 𝑚𝑖𝑛𝑢𝑡𝑒𝑠 = 9.24 ℎ𝑜𝑢𝑟𝑠

Figure S27. Impact of enzymatic degradation on the viscoelastic properties of CSMA hydrogels:
Crosslinked CSMA hydrogels were incubated with 0.83 μg of Chondroitinase ABC in 1 mL of buffer, and 
their viscoelastic properties were evaluated at multiple time points: days 1, 2, 4, 7, and 21. The storage 
modulus (G’) and loss modulus (G”) were measured to assess structural integrity and viscous behavior, 
respectively. A progressive decline in both G’ and G” was observed with increased incubation time, 
indicating gradual enzymatic degradation of the hydrogel network. By day 21, the hydrogels showed a 
substantial reduction in mechanical properties, with G’ decreasing by 33% and G” by 80%, making this a 
representative time point for significant degradation.
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Figure S28: Time dependent swelling behavior of CSMA-PLL hydrogels: (A) Neat CSMA; CSMA-PLL 

hydrogel with PLL DP 15 (B) 2.5% w/w (C) 5% w/w; CSMA-PLL hydrogel with PLL DP 35 (D) 2.5% w/w (E) 

5% w/w; CSMA-PLL hydrogel with PLL DP 50 (F) 2.5% w/w (G) 5% w/w. Data indicated in different color 

corresponds to different samples of the same hydrogel type.

A.2 Collagen quantification in CSMA-PLL hydrogels stained with Sirius Red using ImageJ
Collagen content within cell-laden hydrogels stained with Sirius Red was quantified using ImageJ through 

a standardized image analysis workflow. Initially, images of the stained hydrogels were opened in ImageJ 

(File > Open). An RGB stack was generated (Image > Type > RGB Stack) for these images, allowing 

separation into red, green, and blue channels. The red channel, which most clearly represents Sirius Red 

staining, was selected by splitting the stack into individual grayscale images (Image > Stacks > Stack to 

Images). Thresholding was then applied to the red channel image (Image > Adjust > Threshold), adjusting 

the sliders to isolate collagen-stained regions while minimizing background detection. After thresholding, 

the image was converted to binary format (Process > Binary > Make Binary), and the spatial scale was set 

for quantitative measurements (Analyze > Set Scale). The stained collagen area was measured using the 

particle analysis tool (Analyze > Analyze Particles), with appropriate settings to capture relevant features 

and summarize results. To calculate the percentage of collagen-stained area, the area stained for collagen 

was divided by the total image area, which was determined separately by thresholding the entire hydrogel 

image prior to collagen-specific thresholding. The resulting value was expressed as a percentage: 

(Collagen Area [%] = [Collagen-stained area / Total hydrogel area] × 100). The percentage of collagen-
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stained area was further normalized to the number of live cells within each hydrogel sample. Live cell counts 

were determined using ImageJ by analyzing fluorescence or live cell staining images specific to each group. 

This normalization allowed collagen deposition to be expressed relative to cellular content, accounting for 

variability in cell number across samples and enabling more accurate comparisons of collagen production 

on a per-cell basis (Figure S24). All measurements and processed images were saved for record-keeping 

and further analysis (File > Save As). 

Figure S29: Collagen staining using Sirius Red and quantification of % collagen area: Human 

mesenchymal stem cells (hMSCs) were either cultured on tissue culture plastic (TCPS) as a control or 

encapsulated in CSMA and CSMA-PLL hydrogels. After 7 days in growth media, the cells were maintained 

in chondrogenic differentiation media for an additional 3 weeks. Collagen production was assessed by 

staining with Sirius Red F3B. The stained area, visualized under cross-polarized light (90°) to detect 

birefringence, was analyzed using ImageJ to determine the percentage of the hydrogel area stained for 

collagen. This value was normalized to cell number and reported as % collagen area per cell. The box plot 

represents the 25th and 75th percentiles as the edges of the box, with the median indicated by the line 

inside the box. The error bars in the box plots correspond to the interquartile range (IQR), n=3.
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